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Kata Pengantar

StarUML adalah platform pemodelan perangkat lunak yang
mendukung UML (Unified Modelling Language), berbasiskan pada
UML versi 1.4, menyediakan sebelas jenis diagram yang berbeda, dan
mendukung notasi UML 2.0. StarUML mengklaim diri sebagai salah
satu alat pemodelan perangkat lunak terkemuka yang menjamin dapat
memaksimalkan produktivitas dan kualitas proyek perangkat lunak
Anda.

Buku ini ditujukan bagi mereka yang membutuhkan sebuah alat
bantu (tool) dalam memvisualisasi, merancang, dan mendokumentasikan
sistem perangkat lunak dengan bahasa pemrograman yang berorientasi
objek (C++, Java, C#, VB.NET, Python).

Buku ini memberikan panduan langkah demi langkah yang
dilengkapi dengan gambar screenshot, misalnya dalam membuat
Sequence Diagram, serta dilengkapi dengan sebuah studi kasus yang
dapat membantu pembaca meningkatkan pemahaman mengenai teori
dan praktiknya.

Buku ini terdiri atas 8 bab, yaitu:

e Bab1l membahas tentang pengenalan StarUML

e Bab 2 membahas tentang cara mendapatkan dan menginstal
StarUML

e Bab 3 membahas tentang Project di StarUML

e Bab4 membahas tentang Use Case Diagram dan Use Case
Description serta cara membuatnya

e Bab5 membahas tentang Activity Diagram dan cara mem-
buatnya



e Bab6 membahas tentang Class Diagram dan cara membuat-

nya
e Bab7 membahas tentang

buatnya .
e Bab8 membahas tentang contoh studi kasus

Sequence Diagram dan cara mem-

Kami mengucapkan terima kasih kepada semua pihak yang telah
membantu penyusunan buku ini. Seperti pepatah mengatakan “tak ada
gading yang tak retak”, buku ini pun tidak luput dari kesalahan walaupun
kami sudah berusaha semaksimal mungkin untuk menghindarinya.
Oleh karena itu, kami selalu menghargai setiap kritik dan saran dari
pembaca.
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BAB I

Pengenalan StarUML

Apa itu StarUML?

tarUML™ adalah platform pemodelan perangkat lunak yang men-
Sdukung UML (Unified Modeling Language). StarUML™ yang ber-

basiskan pada UML versi 1.4, menyediakan sebelas jenis Diagram
yang berbeda, dan mendukung notasi UML 2.0. StarUML™ juga secara
aktif mendukung pendekatan MDA (Model Driven Architecture) den-
gan mendukung konsep UML profile. StarUML™ unggul dalam hal kus-
tomisasi lingkungan kerja pengguna, dan memiliki ekstensibilitas tinggi
pada fungsionalitasnya. StartUML™ mengklaim diri sebagai salah satu
alat pemodelan perangkat lunak terkemuka yang menjamin dapat me-
maksimalkan produktivitas dan kualitas proyek perangkat lunak Anda.

Versi StarUML

StarUML pada mulanya dikenal dengan nama “Plastic’ atau “Agora
Plastic”. Pada saat buku ini ditulis, versi StarUML yang digunakan adalah

versi terbarunya yaitu versi 5.0. Beberapa versi yang pernah muncul se-
belumnya adalah:



Tabel 1. 1 Versi StarUML

1996 Plastic versi pertama (v0.9)
Tool sederhana yang digunakan untuk menggambar modul perangkat lunak
1997 Plastic 1.0
Freeware, mendukung OMT
1998 Plastic 1.1
Mendukung UML Class Diagram
1999 Plastic 2.0
Mendukung UML, Java Code generation dan reverse engineering
2001 Plastic 3.0
Mendukung penuh UML 1.3
2003 Plastic 2003
Didesain dan ditulis ulang secara total, mendukung UML 1.4 secara penuh, arsitektur
bersifat terbuka
2005 Agora Plastic 2005
2005 StarUML5

Open source Project, mendukung UML 2.0

Sumber: http://staruml.sourceforge.net/en/about-3.php

Fitur-fitur Utama StarUML
Fitur-fitur utama dalam StarUML versi 5.0 adalah:
1. Dukungan terhadap Diagram UML 2.0:

TSaea™m™eanon

Use Case Diagram

Class Diagram

Sequence Diagram

Collaboration Diagram

Statechart Diagram

Activity Diagram

Component Diagram

Deployment Diagram

Composite Structure Diagram (UML 2.0)

Dukungan terhadap beberapa bahasa pemrograman:

® a0 oQq

Java Profile, Code Generator, dan Reverse Engineer
C++ Profile, Code Generator, dan Reverse Engineer
C# Profile, Code Generator, dan Reverse Engineer
Microsoft Office Document Generation

Microsoft Word document template and generation
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o

i. Automatic Index generation
iit. Automatic TOC (Table of Contents) update

f  Microsoft Excel document template and generation
g. Microsoft PowerPoint document template and generation
Customizable Code Generation

a.

Text-based code template and generation

b. Script-enabled (JScript)
Mendukung teknologi MDA (UML profiles dan Diagram yang
dapat dikustomisasi)

a.

. Mendukung User-defined UML profile (XML)

Diagram yang dapat diperluas (tentukan sendiri jenis Diagram
Anda di luar Diagram UML)

a. Mendukung User-defined Diagram (seperti ERD, BPMN, dsb)
b. Mendukung LISP-style NX (Notation Extension) language
Extensibility

a. Open APl (COM Automation)

b. COM-based plug-in architecture

c. Event subscription

d. Model template (named as Approach)

e. Model framework support (MFC, JZEE, ....)

f Controlling Units and Fragments

Kompatibiltas yang tinggi

a. Rational Rose Import

b. XMl 1.1 - UML 1.3 Import, Export (Unisys XMl support)
Editing

a. Quick dialog

b. Short-cut commands

c. Multiple Undo/Redo

d. Diagram overview

e. Keyboard manipulations

User-Interface

a. VS.NET look and feel

b. Dockable windows

10. Model Verification (based on UML 1.4 well-formedness rules)
11. Pattern Support

a.
b.

GoF, EJB patterns
User-defined patterns

Pengenalan StarUML 3




System Requirements |
Persyaratan minimal yang dibutuhkan untuk menjalankan StarUML 5 0

adalah sebagai berikut:

4

oo AN

Intel(R) Pentium(R) 233MHz atau lebih tmggl. \

Windows(R) 2000, Windows XP™, atau Ieb!h t!nggf

Microsoft(R) Internet Explorer 5.0 atau lebih tinggi

128 MB RAM (disarankan 256MB)

110 MB hard disc space (disarankan 150MB)

CD-ROM drive

Monitor beresolusi SVGA atau lebih tinggi (disarankan 1024x768)

Mouse atau perangkat sejenis

Step by Step Desain Proyek Menggunakan UML



BAB 11

Instalasi StarUML

Download File Installer

ile installer StarUML 5.0 dapat diunduh secara gratis di website
Fresminya http://staruml.sourceforge.net/en/download.php. Ada-

pun file installer yang digunakan dalam buku ini adalah staruml-
5.0-with-cm.exe dengan ukuran file sekitar 22,19 MB.

Proses Instalasi
1. Klik dua kali file staruml-5.0with-cm.exe

Name Date modified Type Size

@) starumi-5.0-with-cm.exe 9/8/2011140PM  Application 22194 KB

Gambar 2. 1 File Installer StarUML

2. Klik tombol Next



&) Setup - StarUML

Welcome to the StarUML Setup
Wizard

This will install StarUML 5.0.2.1570 on your compaer.

it is recommended that you close all other applications before
(:a‘] I.. u.
Click Next to cortinue, or Cancel to exit Setup.

Gambar 2. 2 Window Setup Welcome

3. Klik pilihan “I accept the agreement”

rﬂ Setup - StarUML

License
Please read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation

L

StarUML - The Open Source UML/MDA Platform
Copyright {C) 2002-2005 - Plastic Software, Inc

This program is free software; you can redistribute t and/or mody &
u\dermetetmsofﬁ\eGNUGenemlPLbicUcememptMﬁedbytheFme

Software Foundation; either version 2 of the License. or (at your option)

arty later version. v

dllacce.p(theagreemeﬁ
1 | do not accept the agreement

Gambar 2. 3 Window License Agreement
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4. Tentukan di direktori mana program StarUML ini akan diinstal. Se-
cara default akan diinstal di direktori "C:\Program Files\StarUML".
Tekan tombol Next untuk melanjutkan.

'ﬂ Setup - StarUML

Select Destination Location
Where should StarlUML be installed?

t_ _ Setup wil install tarUML into the following folder.

To continue, click Next ¥ you would lice to select a diferent folder, click Browse.

 [LBowse..

A least 111.6 MB of free disk space is required

e

Gambar 2. 4 Window Pemilihan Destination Location

5. Tentukan folder Start Menu untuk menampung shortcut-shortcut
program StarUML. Secara default folder-nya adalah “StarUML".
Klik tombol Next untuk melanjutkan.

(ﬂ Setup - StarUML

Select Start Menu Folder
Where should Setup place the program’s shortcuts?

} Setup will create the program’s shortcuts in the following Start Menu folder

To continue, click Next. If you would lie to select a diferent folder. cick Browse
Q = B r-__

Gambar 2. 5 Window Pemilihan Start Menu Folder
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" icon" jika ingin membuat short.
6. Centang kotak “Create a Desktop icon” JiK 3
cut star?JML di Desktop dan sebaliknya hllapgkan centang jika tj.
dak ingin membuat shortcut di Desktop. Klik tombol Next untyy
melanjutkan.

&) Setup - StaruML

Selact Additional Tasks g
Which addtional tasks should be performed? S o

Select the addrional tasks you would lke Setup to perfor while installing StarUML. then
click Next.

Addiional icons:
[¥] Create a desktop icon

Gambar 2. 6 Window Additional Tasks

7. Ini adalah ringkasan instalasi. Klik tombol Back untuk melakukan

perubahan. Jika sudah sesuai, klik tombol Install untuk memulai
proses penginstalan.

& Setup - StarUML

Ready to Install
Whmmbb@m&qQMmem_

mmwmmhm. click 1
e or click Back f you wart to review or
Destination location: ¥

C:\Program Files\StarUML ‘
Start Menu folder:
StarUML

Gambar 2. 7 Window Summa& -
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8. Proses Instalasi sedang berjalan. Klik tombol Cancel jika ingin
membatalkan instalasi.

&8 Setup - StarUML =5 & ]

installing
Please wait while Setup installs StarUML on your computer.

C:\Program Files\StarUML\OptMgr dil

Gambar 2. 8 Window Proses Instalasi

9. Instalasi selesai. Biarkan kotak “Launch StarUML" tercentang, ke-
mudian klik tombol Finish untuk mulai menggunakan StarUML.

Instalasi StarUML 9
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rﬂ Setup - StamML
Completing the StarUML Setup
Wizard

Setup has finished installing StarUML on your computer. The
application may be launched by selecting the installed icons

Click Finish to exit Setup.

[¥] Launch StarUML

Gambar 2. 9 Window Instalasi Selesai
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BAB III

Bekerja dengan Project

Mengenal Project

Sebuah Project dapat mengelola satu atau lebih model perangkat
lunak. Umumnya, satu Project disimpan dalam satu file berformat
XML yang berekstensi “.UML". Semua model, views, dan Diagram yang
dibuat dalam StarUML disimpan dalam satu file Project. Sebuah file
Project menyimpan informasi berikut ini:
1. UML profiles yang digunakan dalam Project
2. Unit file yang dirujuk oleh Project
3. Informasi untuk semua model yang ada dalam Project
4. Informasi untuk semua Diagram dan views yang ada dalam Pro-
Ject '

Project adalah unit manajemen yang paling dasar dalam StarUML.

Membuat Project Baru
Untuk membuat Project baru, ikuti langkah berikut ini:

1. Buka program StarUML. Akan muncul window seperti gambar 3.1
berikut:



New Project By Approach

1| [ Aporoaches [ open Fies | Recent Fles B e
HE

~ & B
b S SR8

Approaches: O == )

Description: iy ) = e
| Blank project.
|

1 , G e

{_}set As Default Approach

Gambar 3. 1 Window New Project by Approach

dimuat, tergantung pendekatan (approach) yang dipilih.

(—7¢3ﬁ¢:

Jika window ini tidak muncul, klik File > New Project By

12

Pendekatan-pendekatan (approaches) yang tersedia
ditampilkan dalam dialog box. Pilih salah satu pendekatan (approach)
lalu tekan tombol OK. Profile dan/atau framework mungkin akan ikut

Approach seperti gambar 3.2 di bawah.

& StarUML | "
| Fe | Edt Fomat model yiew Tools
D“HFLN Project Ctrl+N d
| NewProjectBy Approach... Caiat |
iE oo Tamo
A& save Ctrl+S =

Gambar 3. 2 Menu New Project By Approach
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Menyimpan Project

1. Klik File > Save

& StarUML - use caseuml .
:| Ele | Edit Format Model View Tools
|0 New Project Ctrl+N
New Project By Approach... Cirl+ :
Erﬁ Open... crl+0  F
& save Ctrl+5 JE

Save As... Shift+Ctrl+5 '
a Close

Gambar 3. 3 Menu Save

2. Tentukan di direktori mana file Project akan disimpan. Tentukan
nama file-nya, kemudian klik tombol Save.

Savein: Llﬁi\m e T g O *rr @
x'[. A
L‘} L L
Recent Places
Desktop Untitled.uml| use case.uml
X =
Libraries
Computer
“&.
Network
File name: e case oml - [ Save |
Saveastye:  |StarUML Project Fie( umi) «] [ Conce ]

Gambar 3. 4 Window Save File Dialog
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Membuka Project Lama

Untuk membuka Project lama yang sudah pernah disimpan, kita
dapat mengikuti langkah satu (1) atau langkah dua (2) berikut:

1. Pada dialog box New Project By Approach, klik tab Open Files,
Cari folder tempat file Project disimpan, lalu klik dua kali pada file
Project yang akan dibuka.

{ New Project By Approach

| Approaches | Open Files |Recent Files |

Folders: Files:
1 BT 2thon ~ || Name Size Item type

i i ey Blunttied.umi 77.9KB  StarUML Pr

4. PerfLogs

&4
- 4. Program Files E
d b- PythonZG 1
A |

m
T

) tes
L. Users l

i @4 Windows
@ xampp

¢ @y DATA OK (D:)
. @y Local Disk (E:)

| @y Local Disk (F:) m

Gambar 3. 5 Tab Open Files pada Window New Project by Approach

2. Cara lainnya adalah dengan klik File > Open.
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& StarUML - Untitled.uml

‘| File | Edit Model View Tools Help
| [0 New Project Ctrl+N
- New Project By Approach... Ctrl+]
@om, o
Save Ctrl45
Save As... Shift+Ctrl+5
i Close
Gambar 3. 6 Menu Open

Kemudian, pada Open File Dialog yang muncul, cari folder tempat
file Project disimpan, lalu klik dua kali pada file Project yang ingin
dibuka.

Recent Places
Y : . )y AL

Desktop

Untitled.uml

ST )

Liblraris
Computer
Network {

orone. | - =k

; Flesoftype:  [StarUML Project Fie(".uml) v | Cancel |

>~

Gambar 3. 7 Open File Dialog

Bekerja dengan Project 15




Menutup Project _
Untuk menutup Project, ikuti langkah berikut:

1. Klik File > Close.

{ & StarUML - Untitled.uml

:| File | Edit Model View Tools Help
/[0 New Project Ctrl+N d
3 New Project By Approach... Ctrl+] L
111z open... crl+0
' LE Save Ctrl+5 e
Save As... Shift+Ctrl+5 L
Close ]

Gambar 3. 8 Menu Close

2. Jika Project belum disimpan setelah dilakukan perubahan, akan
muncul pesan peringatan untuk menyimpan Project.
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BAB IV

Use Case Diagram

Pengertian Use Case Diagram

3

permintaan dari pengguna sistem.”
Notasi Use Case Diagram

Stick figure yang

ohn Satzinger, 2010, dalam buku System Analysis and Design in
a Changing World menyatakan bahwa “Use Case adalah sebuah
kegiatan yang dilakukan oleh sistem, biasanya dalam menanggapi

7

Garis penghubung untuk
menunjukkan aktor mana |
yang menjalankan use

‘/,, R

disebut aktor dan 5
mewakili sebuah peran
' case yang mana
f.’/'t
Mahasiswa
Gambar 4. 1 Notasi Use Case Diagram



Tahap-tahap Pembuatan Use Case Diagram

Salah satu langkah awal untuk membuat Diagram Use Case adalah
dengan mengidentifikasi aktor dan proses bisnis dasar.

Langkah-langkah membuat Diagram Use Case:

1. Mengidentifikasi aktor. Perhatikan bahwa aktor sebenarny,
adalah peran yang dimainkan oleh pengguna. Alih-alih menyusyn
daftar aktor sebagai Bob, Maria, atau Tuan Hendricks, sebaiknya
identifikasi peran spesifik yang dimainkan oleh orang-orang
tersebut. Ingatlah bahwa orang yang sama mungkin memainkan
berbagai peran karena ia menggunakan sistem. Sistem lain juga
dapat menjadi aktor dari sistem. Contoh aktor: mahasiswa, dosen,
order clerk, department manager, auditor, dsb.

2. Setelah peran aktor teridentifikasi, langkah berikutnya adalah
menyusun tujuan-tujuan yang ingin dicapai oleh peran-peran
tersebut dalam penggunaan sistem. Tujuan tersebut merupakan
tugas yang dilakukan oleh aktor untuk mencapai beberapa fungsi
bisnis yang memberikan nilai tambah bagi bisnis. Contoh: melihat
info biodata, menyimpan data login, mengirim testimoni.

Use Case Description

Use Case Description merupakan tabel yang digunakan untuk membuat
dan menjelaskan keterangan terperinci mengenai tiap-tiap Use Case.

John Satzinger, 2010, dalam buku System Analysis and Design in a
Changing World menyatakan bahwa “ada tiga jenis Use Case Descriptions
yang digunakan oleh analis, dengan masing-masing tingkat rincian
yang berbeda, yaitu: Brief Description, Intermediate Description, dan
Fully Developed Description, tergantung kebutuhan dari analis.”

Brief Description

Sebuah Brief Description dapat digunakan untuk Use Case yang sangat

sederhana, terutama jika sistem yang akan dikembangkan juga kecil
dan aplikasinya mudah dipahami dengan baik.
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Tabel 4. 1 Brief Description: Melihat Info Biodata

Ketika Mahasiswa menekan tombol biodata di halaman
utama, sistem menghubungi webserver SION, mem-

parsing dan menampilkan halaman biodata.

Intermediate Description

Intermediate Description merupakan pengembangan dari Brief
Description yang berisi aliran aktivitas internal Use Case. Apabila dalam
sebuah Use Case terdapat beberapa scenario, masing-masing aliran
aktivitas dijelaskan sendiri-sendiri dalam sebuah Use Case Description.
Exception Conditions juga dapat dituliskan dalam Intermediate
Description jika diperlukan.

Tabel 4. 2 Intermediate Description: Melihat Info Biodata

Aliran aktivitas untuk scenario melihat info biodata me-
lalui ponsel J2ME

s

0o

Main Flow:

Mahasiswa menekan tombol biodata di halaman utama
Sistem menampilkan animasi loading sebagai tanda bahwa
proses sedang berjalan

Sistem mengambil data NIM, password, dan pilihan format
(XML atau JSON) di RMS ponsel

Sistem membuka koneksi HTTP

Sistem meminta halaman biodata ke webserver SION sesuai
dengan NIM, password, dan pilihan format yang didapat dari
langkah 3

Sistem mem-parsing halaman biodata yang masih berupa
format XML atau JSON

Sistem menampilkan informasi biodata yang sudah di-parsing
Sistem menghilangkan animasi loading

Sistem menutup koneksi HTTP
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Exception Conditions:

5.1 Jika sistem tidak mampu me
sistem akan menampilkan pesan
menuju langkah 9 .

6.1 Jika sistem tidak mampu me :
sistem menampilkan pesan error dan langsung menuju lang-

kah 9

nghubungi webserver SION
koneksi error dan langsung

-parsing halaman biodata,

Fully Developed Description | |
Fully Developed Description adalah metode yang paling resmi untuk
mendokumentasikan sebuah Use Case. Untuk membuat Fully Developed
Description kita perlu mendefinisikan semua komponen pada tingkat

nl.
Tabel 4. 3 Fully Developed Description: Melihat Info Biodata
Use Case Melihat info biodata
Name:
Scenario: Melihat info biodata melalui ponsel J2ME
Triggering Mahasiswa menekan tombol biodata di halaman utama
Event:
Brief Descrip- | Ketika mahasiswa menekan tombol biodata di halaman utama,
tion: sistem menghubungi webserver SION, mem-parsing dan me-
nampilkan halaman biodata
Actors: Mahasiswa
Related Use | -
Cases:
Stakeholders: | -
Precondi- Data login (NIM dan password) di RMS ponsel tidak boleh kosong
tions:
Postcondi- Sistem menampilkan informasi biodata mahasiswa
tions:
20
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Flow of Ac- Actor System
tivities: 1. Mahasiswa menekan tombol | 1. -

biodata di halaman utama 2. Sistem menampilkan

animasi loading sebagai
tanda bahwa proses
sedang berjalan

3. Sistem mengambil data
NIM, password, dan
pilihan format (XML
atau JSON) di RMS
ponsel

4. Sistem membuka
koneksi HTTP

5. Sistem meminta
halaman biodata ke
webserver SION sesuai
dengan NIM, password,

dan pilihan format yang

didapat dari langkah 2
6. Sistem mem-parsing

halaman biodata yang

masih berupa format
XML atau JSON

7. Sistem menampilkan

informasi biodata yang
sudah di-parsing

8. Sistem menghilangkan

animasi loading

9. Sistem menutup
koneksi HTTP
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Exception 5.1 Jika sistem tidak mampu menghubungi webserver SION,
Conditions: sistem akan menampilkan pesan koneksi error dan langsung

menuju langkah 8

6.1 Jika sistem tidak mampu mem-parsing halaman biodata,
sistem menampilkan pesan error dan langsung menuju lang-

kah 8 el

Keterangan Tabel:

ks

22

Use Case Name dan Scenario digunakan untuk mengidentifikasi
Use Case dan scenario di dalam Use Case. Apabila dalam sebuah
Use Case terdapat beberapa scenario, masing-masing aliran ak-
tivitas dijelaskan sendiri-sendiri dalam sebuah Use Case Descrip-
tion.

Triggering Event mengidentifikasikan peristiwa pemicu yang
memulai Use Case.

Brief Description adalah deskripsi singkat tentang Use Case atau
scenario. Di sini, analis dapat menduplikasi deskripsi singkat yang
telah mereka buat sebelumnya.

Actors mengidentifikasi aktor-aktor yang berperan dalam Use
Case.

Related Use Case mengidentifikasi Use Case lain dan cara mereka
terkait dengan Use Case ini. Referensi silang ke Use Case lain ini
membantu mendokumentasikan semua aspek kebutuhan peng-
guna.

Stakeholders mengidentifikasi pihak-pihak yang berkepentingan,
di luar aktor yang disebutkan. Mereka mungkin pengguna yang
tidak benar-benar memanggil Use Case tetapi tertarik pada hal
yang dihasilkan oleh Use Case tersebut.

Preconditions dan Postconditions, memberikan informasi penting
mengenai keadaan sistem sebelum dan sesudah Use Case
dieksekusi.

Dua baris terakhir dalam Fully Developed Description menjelaskan
aliran aktivitas terperinci dari Use Case. Penomoran item
membantu mengidentifikasi urutan langkah-langkah. Beberapa
pengembang lebih suka versi saty kolom, seperti yang ditunjukkan
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di Intermediate Description. Kegiatan alternatif dan Exception
Conditions dijelaskan dalam baris akhir. Penomoran Exception
Conditions juga membantu mengikat pengecualian dengan
langkah-langkah spesifik dalam Use Case Description.

Langkah-langkah Membuat Use Case Diagram di
StarUML

Untuk membuat Use Case Diagram dalam StarUML silakan ikuti
langkah-langkah berikut:

1. Buat sebuah Project baru. Pilih Empty Project di pilihan ap-
proaches, lalu tekan tombol OK.

Fos e o
New Project By Approach u
" Approaches | Open Files | Recent Fies | - 15 -
Approaches: @ =
CRrRCE) ‘
4+1 View Default Rational UML Empty Project
Mode! Approach Approach ~ Compone...
Description: i o o
Blank project.
Set As Default Approach

Gambar 4. 2 Pilihan Approaches Saat Membuat Project Baru

2. Cari kotak Model Explorer, kemudian klik kanan icon kubus yang
berlabel Untitled, lalu pilih Menu Add, kemudian klik Menu Mod-

el
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|

24

AERE- ML AR

| Untitied
21 Model Add 3
&1 Subsystem Add Diagram »
01 Package 1Y cut Ctri+X
S i i S

Gambar 4. 3 Add Model Baru untuk Use Case Diagram

| SRR e
IR MR AR

= ™ Untitled
- B IEER

i E Model Explorer | @ Diagram Explorer I
|Properties o R x|
| (UMLModel) Model1 |
=

¢ Name Model1

¢ Stereotype

v Visibility ¢ PUBLIC

& IsAbstract |

# IsSpecification 0
¢ IsRoot 0
¢ IsLeaf ]

Gambar 4. 4 Model yang Baru Ditambahkan pada Project
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~Tipe:

Jika kotak Model Explorer tidak muncul di area kerja
StarUML, klik menu View, kemudian klik untuk mencentang
menu Model Explorer.

View | Tools Help
4 Close Diagram Ctrl+F4
] Close All Diagrams  Shift+Ctrl+F4
g Select In Model Explorer  Ctrl+M 3
{%| Refresh F5
¥ | Model Explorer
F Diagram Explorer

Gambar 4. 5 Menampilkan Model Explorer

oax

HIERE-MR SR
- ™ Untitled

Use Case Model

Gambar 4. 6 Memberi Nama Use Case Model

4. Tambahkan sebuah Use Case Diagram baru ke Use Case Model
dengan cara klik kanan label Use Case Model, lalu pilih menu
Add Diagram, kemudian klik menu Use Case Diagram.
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Add ~~_.L
= 1 NEER bl
4] Class Diagram it w 2 e AT SIS |

{@ Use Case Diagram X cut Ctri+X
=] Sequence Diagram Copy Ctri+C

Gambar 4. 7 Menambahkan Use Case Diagram ke Use Case Model

5. Anda dapat memberikan nama sendiri untuk Use Cqsg Diagrarp
yang baru ini atau membiarkan nama default-r)ya. Di sini penulis
membiarkan nama default-nya yaitu UseCaseDiagram1.

| Model Explorer

IHEE-RE AR
v 5 % Untitled .
| = [E&] Use Case Model

: @ UseCaseDiagram1

!
f
i
3
|
|
{
|
|

Gambar 4. 8 Memberi Nama Use Case Diagram

6. Setelah menambahkan UseCaseDiagram1, pada kotak Toolbox
akan muncul dua buah tab, yaitu tab Annotation dan tab UseCase

(terbuka secara default). Klik label tab untuk membuka tab terse-
but sekaligus menutup tab yang lain.
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Wodbon " IR R
Annotation f
UseCase | -

,r[} e
1 Package

O UseCase

+ Actor

_| Assodation

1 DirectedAssodation
_T Generalization

" Dependency

13 Indude

£7 Extend

[[] System Boundary

Gambar 4. 9 Tab UseCase di Toolbox

Tab UseCase berisi notasi yang dapat dipergunakan dalam mem-
buat Use Case Diagram.

Annotation | - |

[y select
A Text

4 Note

™" NoteLink
] Rectangle
> Ellipse

() Rounded Rectangle

Gambar 4. 10 Tab Annotation di Toolbox
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Tab Annotation adalah notasi standar yang dapat dipergunakan
hampir di semua jenis Diagram dalam StarUML. Notasi yang ada
biasanya dipergunakan untuk membuat keterangan pada Dig-

gram.

Untuk membuat sebuah aktor, tampilkaq dulu tab UseCase yang
ada di Toolbox, lalu klik notasi yang ber-icon orang dengan labgl
Actor, kemudian klik sekali lagi di area kosong di lembar kerja.

Ketikkan nama untuk aktor ini, lalu tekan tombol Enter.

& StaUML

O R
il Rl

! Ele Edit Forma
DEES s2e

Model View Tools Help

X|oc«dd | ZBFR | ¥ 100

i d
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| Toolbox

Annotation

UseCase
Ty select

3 Package

< UseCase

2 Actor

_| Assodation

_T DirectedAssodation
_4* Generalization

17 Indude
EZ Extend

[[] System Boundary

|
=

o x|

<] A .2 R

e

Mahasiswa

Gambar 4. 11 Membuat Actor

8. Untuk membuat sebuah Use Case, pastikan tab UseCase yang ada
di Toolbox masih tampil, lalu klik notasi yang ber-icon oval dengan
label UseCase, kemudian klik sekali lagi di area kosong di lembar
kerja. Ketikkan nama untuk Use Case ini, lalu tekan tombol Enter.
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& StarlUML

e )

fle Edt Fomat Model Vew Took Hebp

DeE& ¢ ?\l‘)ﬁ'ﬂ:‘n“'[’i{?ﬁ‘ﬁy' 100% . a@m
-l asegimad|TEEsmro =
Toobox @ x|[UseCaseDiagram1 (Use Case Mode)
Annotation [ — 'JI'I' T i R
scme e £

R select 1

[ Padkage ;

O UseCase ’;

% Actor E

T DirectedAssodation ,

4§ Generalization t

T Dependency 1 % Melhat Info Biodata

£ Extend ‘i

] System Boundary r

Gambar 4. 12 Membuat Use Case

9. Untuk membuat asosiasi antara Actor dan Use Case, klik icon garis
berlabel Association pada tab UseCase di Toolbox, kemudian klik-
tahan-seret mulai dari Actor Mahasiswa ke Use Case Melihat Info
Biodata (pada saat ini, garis asosiasi masih terlihat terputus-pu-
tus). Lepaskan mouse jika posisi awal dan akhir garis sudah tepat

berada di atas Actor dan Use Case.

Use Case Diagram
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K SaumL @0 B
*Beﬁﬁtwmtuoddwewlwbueb

DEE&s b X|ocRREGBBE. v -aag
Pt S ST P — |
‘ T_a.22|0 % &é‘l" Ll m e

[Toolbox n x| e
Annotation

UseCase |
[} select

3 Package

O UseCase

£ Actor

|"_I Association

7 Directedassodation

T T s
2 Dependency
i tncute “""

3 Extend
[[] System Boundary

|

Gambar 4. 13 Membuat Asosiasi Antara Actor dan Use Case

Apabila garis Association sudah digambar dengan benar, maka
Use Case Diagram akan tampak seperti gambar di bawah:

wShrUML A R
FleEthgrmatModd!:eonolqu;

DBE@ ¥ J‘nnxﬂﬂuﬁﬁimf. B39, 7100%

il i it ,I A I 0 "J,, ¥ ‘éz -

o 5 x Z i 1
& ; e

[Toolbox

Annotation
UseCase

&y select
3 Package
O UseCase

= | X
12 Indude Mahasiswa

Gambar 4. 14 Association Antara Actor dan Use Case
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Jika terdapat kesalahan saat menghubungkan actor dengan Use
Case, akan muncul pesan kesalahan seperti gambar di bawah.

Gambar 4. 15 Pesan Kesalahan Saat Menggambar Garis Asosiasi

Untuk menggambar garis lain (DirectedAssociation, Generaliza-
tion, Dependency, Include, Extend) caranya sama seperti meng-
gambar garis Association.

Penggunaan masing-masing garis dalam notasi Use Case

Diagram tidak dijelaskan dalam buku ini.

10. Untuk menggambar notasi System Boundary, Klik icon-nya di tab
UseCase di Toolbox, lalu klik-tahan-seret di area kerja (pada saat
ini system boundary masih terlihat sebagai garis putus-putus).
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oo R ZIAR| G 8. 100% - Q@ 3.
A7 L m |22 -- s T, |

Gambar 4. 16 Menggambar System Boundary

Lepaskan mouse setelah posisi dan ukuran notasi System Bound-
ary sudah sesuai.

& StaML - - il
| He Edt Fomat Model Vew Took Hep
DEES s RRX v -#ZTARa e, [wm% -a@3.

i -] A2 Qg ST smetaEs e

[Toobbox DN R R DRt
mll

| R select System

[ Package

O UseCase

_§ Generalization
1 Dependency
17 Indude Mahasiswa
£ Extend
[[] System Boundary
Gambar 4. 17 System Boundary di Use Case Diagram
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11. Untuk menyimpan Project, klik File > Save.

Savein: | Lathan

v e E_, e v
-unL AL A unL
langkah notasi activity  study kasus.uml Untitled.uml
_.Jangkah.uml | diagram.umi
Computer
“
Net;ork e Bl R TR e U S g T S
File name: langkah langkah - [ save ]
Saveastype: [StarlML Project Fileumi) v [ GCancel ]

Gambar 4. 18 Menyimpan Project

Simpan Project di folder yang diinginkan dengan nama file: Use
Case, dan type: StarUML Project File (*.uml).

12. Untuk menyimpan Use Case Diagram sebagai file gambar, klik File
> Export Diagram.

Use Case Diagram 33



A StarUML - langkah langkah.uml

| Eile l Edit Format Model View Tools
‘I[) New Project Crl+N 4
New Project By Approach... Ctrl+1 :
[Ij’ Open... Ctrl+0 Ef
& save culs [
U savess. Shift+Ctrl45
l: Close
Unit >
Import >
Export »
Export Diagram. .. Shift+Ctrl+D

Gambar 4. 19 Export Use Case Sebagai File Gambar

13. Pada dialog box Export Diagram yang muncul, tentukan folder
tempat penyimpanan, nama file, dan tipe file yang diinginkan, ke-
mudian tekan tombol Save.

[ 4 Export Dagram e
Savein: j, Lathan - 02 r@E
< :
Recent Places - =
w : 3 o3 :
Deskt: '
op ActivityDiagram... tes, pg UseCaseDiagram...

m
Libranes

A

Computer

Gambar 4. 20 Save File Dialog Saat Mengexport Use Case
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14. Use Case Diagram yang telah di-exp

: ort ke dal
tampak seperti gambar di bawah: alam file gambar akan

System

Melihat Info Biodata

e

Gambar 4. 21 File Gambar Use Case
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BAB YV

Activity Diagram

Pengertian Activity Diagram

John Satzinger, 2010, dalam buku System Analysis and Design in a
Changing World menyatakan bahwa “Activity Diagram adalah sebuah
Diagram alur kerja yang menjelaskan berbagai kegiatan pengguna
(atau sistem), orang yang melakukan masing-masing aktivitas, dan
aliran sekuensial dari aktivitas-aktivitas tersebut.”

Notasi Activity Diagram

Notasi umum yang sering digunakan dalam Activity Diagram adalah
sebagai berikut:

Swimlane(vertica | Synchronization (Split)
Swimlane(horizontal /s

InitialState

ActionStat

Synchronization (Join)

Gambar 5. 1 Notasi Activity Diagram




2. Pada saat ini kita baru memiliki sebuah model, yaitu Use Cggpe

Model.

O

@Use(:asemdd

53 wode Exporer [ Dagram xplre |

Gambar 5. 4 Model Explorer yang Baru Memiliki Satu Buah Model

3. Sebelum membuat Activity Diagram, kita perlu membuat sebuah
model baru. Klik kanan ikon kubus berlabel Untitled yang ada
pada kotak Model Explorer, kemudian pilih menu Add, lalu klik
menu Model.

&} Model ,
[A1 Subsystem 1 Add Diagram »
:1 Pac}ege & out Ctri+X
Copy CtreC
B Ppaste CtrlsV
Delete From Model Ctri+Del

Gambar 5. 5 Menu Add Model untuk Membuat Activity Model
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4. Beri nama model baru ini dengan nama Activity Model.

) Activity Model

Gambar 5. 6 Activity Model yang Baru Dibuat di Model Explorer

5. Uptuk menambahkan Activity Diagram ke dalam Activity Model,
klik kanan Activity Model, lalu pilih Menu Add Diagram, kemudian
klik Menu Activity Diagram.

=3 j Unhﬁed
] Use Case Model

Add »
Class Diagram Add Diagram 5
Use Case Diagram 4 cut CtrhX
] Sequence Diagram Copy crlC
2] Sequence Diagram (Role) ‘@ Paste Ctri+V
Collaboration Diagram Delete From Model Ctrl+Del
7 Colaboration Diagram (Role) Unit >
Statechart Diagram -

} Collection Editor...  Ctr+FS

Constraints... Ctri+F6
Component Diagram ik -

Tag es...
Deployment Diagram -
. Composite Structure Dﬁgﬁm CH ;

Gambar 5. 7 Menu untuk Menambahkan Activity Diagram
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6. Ganti nama ActivityGraphl menjadi Actiyi{yGrfJPhMelihat/nfoB,'o_
data, dan ActivityDiagraml menjadi Act_tVtQ/DtagramMelihatInfo-
Biodata (sesuai dengan Use Case Description yang ingin dibyat.

kan Activity Diagram-nya).

SRS <
{

[ERE TR AR I
=
-[& Use Case Model
£ B Activity Model

= ‘2| ActivityGraphMelihatinfoBiodata |
@ ActivityDiagramMelihatInfoBiodata

- & TOP

i @ Model Explorer Diagram Explorer |

Gambar 5. 8 Mengganti Nama Activity Graph dan Activity Diagram

7. Untuk mulai menggambar Activity Diagram pada area kerja, pas-
tikan tab Activity sudah ditampilkan dalam Toolbox. Jika belum
ditampilkan, klik dua kali pada ActivityDiagramMelihatInfoBiodata
pada kotak Model Explorer.
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| Toolbox 3 x|
Annotation I
Activity |
I\ select "
0 ActionState
(& SubactivityState
® InitialState

@ FinalState

3]+ Synchronization
<> Dedsion

& Flow Final
=] Object Flow
X Signal Accept State |
= Signal Send State |
_T Transition |
) SelfTransition

| Swimlane(Vertical)

— Swimlane(Horizontal)

!

Gambar 5. 9 Toolbox Activity Diagram

8. Activity Diagram adalah penggambaran Flow of Act[yities yang
terdapat di dalam Use Case Description ke dalam notasi UML. Per-
hatikan “Fully Developed Use Case Description Melihat Info Bio-
data” pada Bab IV, gambarkan semua “Flow of Activities’-nya kg
dalam Activity Diagram. Pada Use Case Description ini, kita memi-
liki dua agen, yaitu Mahasiswa dan System, serta sembilan buah

activity.

9. Untuk menggambarkan agen ke dalam area kerja, klik icon garis
tebal berlabel Swimlane (Vertical) pada tab Activity yang terdapat.
di Toolbox, kemudian klik pada area kerja. Ubah namanya dari
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Swimlanel menjadi Mahasiswa. Buat satu Syvimlgne lagi (de?”gan
cara yang sama) dan ubah namanya me"Jad' YSth Sehnngga
kita memiliki dua swimlane yang berdampingan pada area kerjy

kita.

¥ StarUML - use case.uml
fle Edt Fomat Model ew Took UeP .
N EES i bRX|ooRRARE R 100% *_@ I

M@E@é@wﬁ@_@wwmmmm :

O —— o S Y——
Activity ]l .
h Select | Mahasiswa

System

O ActionState

@ SubactivityState

® InitialState ,
@ FinalState }
3} Synchronization '
<> Dedsion

® Flow Final '
31 Object Flow &
X Signal Accept State
[ Signal Send State

_T Transition

€ selfTransition

| swimlane{Vertical)
— Swimlane(Horizontal)

Gambar 5. 10 Swimlane Mahasiswa dan System

10. Sebelum menggambar activity pertama, terlebih dahulu kita
gambar InitialState dengan label Start, tepat di dalam swimlane
yang memulai Use Case ini. Klik icon lingkaran berlabel InitialState
di tab Activity yang berada pada Toolbox.
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StarUML - use case.uml A
X b T

He Edt Fomat Model Vew Toos Hep

DHFESIRBX (0 HBAR a9, w00 -8 @ 3
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tation

"

£ B o -t Mt
B AT T s me
'“‘;.’/ :’if" ity Mod bl anhiMalia  TnfoRiseda ts) :',,,'1.". s

= e R
| 3] ActivityDiagramMeliatinfosiodata | B useCaseniagram

'—Qs*d

® IntialState
@ FnalState
3} Synchronization

Mahasiswa System

1
|
i
3
a

l
|

Gambar 5. 11 InitialState

11. Untuk membuat labelnya, klik tab Annotation yang berada di
Toolbox, klik icon A berlabel Text, lalu klik area kerja tepat di atas
notasi InitialState, kemudian ganti text menjadi Start, lalu klik di
area kosong pada area kerja.

& StrML- use caseuml O g o F—

{ fle Edt Fomat Model View Tools Help
DSE&smX N B3IR | a R, [100% - Q@ 7]

% Tahoma

{Toobox

Annotation

[T3 select

A Text

[ Note

i~ Notelink

[C] Rectangle

O Elipse

(D Rounded Rectangle

Gambar 5. 12 Label untuk InitialState

12. Selanjutnya, sesuai dengan flow of activities yang sudah kita
buat pada tabel “Fully Developed Use Case Description Melihat
Info Biodata” pada Bab 1V, kita gambarkan activity pertama yaitu
“Mahasiswa menekan tombol biodata di halaman utama’, seperti

gambar berikut ini:

Activity Diagram 45



13.

46

g StrUML - use case, setivitywomd e
Fle Bt Fgmat Medd Yew Toch Heb j

DE @@ hnXncMH@ARSSN. DO
| AN P4

Ghety

Start

@ SubactivityState

@ InbalState {

® e

) Cbject Flow
I Signal Accept State
L Sgnal Send State
1 Transibon

5 Seiffvansiton

| Swrlane(verscal)
= Swimiane{Horizontal)

Gambar 5. 13 ActionState Pertama

Selanjutnya, kita gambarkan semua activity yang ada dalam flow
activities, sesuai dengan urutan dan agen yang melakukannya.
Hasil akhir dari pembuatan Activity Diagram untuk tabel “Fully
Developed Use Case Description Melihat Info Biodata” pada Bab
IV adalah seperti gambar di bawah:

Mahassiva System
Start

{(Menekan tombl biodata di halaman utama Menampikan animasi loadng

Gambar 5. 14 Activity Diagram yang Sudah Jadi
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14. Untuk saat ini, jika kita perhatikan Model Explorer, kita telah me-
miliki Use Case Model dan Activity Model seperti gambar di bawah

ni.

UseCaseDiagram 1 ‘
- © Melihat Info Biodata [
- % Mahasiswa ]
= & Activity Model
& 2| ActivityGraphMelihatinfoBiodata
- [&] ActivityDiagramMelihatinfoBiodata
= 5 T0P
: Menekan tombol biodata di halaman utama
Menampilkan animasi loading
mengambil data NIM, password, pilihan for
membuka koneksi HTTP
meminta halaman biodata ke webserver SI
memparsing halaman biodata é
menampilkan informasi biodata
menghilangkan animasi loading
menutup koneksi HTTP
, Initiall
- @ FinalState1
| Mahasiswa
| system

e00000000Q

Gambar 5. 15 Model Explorer

15. Simpan Project kita dengan nama “Use Case, activity.uml”.
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Apaticttiocta ETER
2 — ]
< ik Save As - — T
- ey @ g
Savein: j, Lathan
b . X h
| ¥ 47
! A omL
Desltto‘p Untitled.uml use case, use case.uml
== activity.um!
=
Libraries
.
Coméuter
Network oo SRS s e
File name: use case, activity.uml ¥ Save
Sweastpe  [SaUMLPmctFieCum) . @] | Cancd |
\

Gambar 5. 16 Save File Dialog
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BAB VI

CLASS DIAGRAM

pengertian Class Diagram

ohn Satzinger, 2010, dalam buku $ 1 ign i

' : ystem Analysis and Design in a
Changtng World menyatakan bahwa “dalam UML, ada duajer{;is class
Diagram yaitu: domain class Diagram dan design class Diagram.”

Domain Class Diagram

Menurut Satzinger: "ngus domain class Diagram adalah pada sesuatu
dalam lingkungan kerja pengguna, bukan pada class perangkat lunak

yang nantinya akan Anda rancang.”
+HNIM

Biodata ] A Nama Class
+Hama

+AlamatOrangTua
+Jumlahkakak
+NoTelepon
+Jurusan

+Agama i
ksl 4 —/l_l Attribute
+5tatus
+NoHandPhone
+JumlahAdik
+MNamalbu
+Tempat/TglLahir

Gambar 6. 1 Notasi Domain Class Diagram



. jagram -
Design Class D1ag Jalah  untuk mendokumentasikan
Tujuan utamanya a

lam emrograman yang nantinya aky
gfnggambl;n@nnkelas—kelas dalam p ambarkan kelas berorientasni
ibangun. Desg

Diagram mengg o
objek yang dibuturfll(c;Srf dalagn pemrograman,dnaa\/'rg:::jg;\antar a kelas
attJribute names, dan propertinya serta metfho n d'kpr Opertiny,
Gambar 6.2 me’nunjukkan domain.class Dlazg)r‘amayr:r—]r? a' Smb-angk.a”
pada tahap analisis dan versi design class tagbf dl)lb ersi desig
class Diagram memiliki sebuah kompartemen télrg ; agian ba}/Vah
yang menentukan method signatures. Atribut-atribut yang ada jug,

ditingkatkan.
Biodata Biodata
+Nama Hama: 5tring i
+AlamatOrangTua +AlamatOrangTua: String
+lumlahkakak +lumlahkakak: Integer
+NoTelepon +NoTelepon: String
+Jurusan +Jurusan: String
+Agama +Agama: 5tring
+MNamaAyah +Mamaayah: String
+Status +5tatus: Integer
+MoHandPhone -+NoHandPhone: String
+JumlahAdik +Jumlah&dik: Integer
Hilamalbu +Mamalbu: 5tring
+Tempat,TglLahir +Tempat/TalLahir: String
+GetBiodata(NIM)
Domain Class Diagram
Design Class Diagram

Gambar 6. 2 Class Biodata yang Digambarkan dengan Domain Class Diagram
dan Design Class Diagram
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Notasi Design Class Diagram

< <Stereotype Name> >
Class Name::Parent Class

Attribute List
visibility name:type-expression = initial-value {property}

Method list
Visibility name(parameter list): type-expression

[ .

Gambar 6. 3 Notasi Design Class Diagram

Format yang digunakan oleh penganalisis untuk menjelaskan
masing-masing atribut termasuk di antaranya:

1. Attribut Visibility/Visibilitas atribut. Visibilitas menunjukkan
apakah objek lain dapat dengan langsung mengakses atribut.
(Tanda + menunjukkan bahwa atribut tersebut terlihat (public),
dan tanda — menunjukkan bahwa atribut tersebut tidak terlihat
(private)).

2. Atribute Name/Nama atribut

3. Type-expression/Tipe-ekspresi (seperti character, string, integer,
number, currency, atau date)

4. Initial-value/Nilai awal

5. Property (dalam kurung kurawal), misalnya {key}

Kompartemen ketiga berisi informasi method signature. Sebuah
method signature menunjukkan semua informasi yang diperlukan
untuk meminta (memanggil) method tersebut. Method signature
menunjukkan format message yang harus dikirim, yang berisi:

1. Method visibility/visibilitas method

2. Method name/nama method

3. Method parameter list/daftar parameter method (argument yang

masuk)
Type-expression/tipe-ekspresi
Tipe dari parameter yang dikembalikan oleh method

4.
5
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at Class Diagram di StarUm_

? Membu . -
Langkah-langkah ram di StarUML, silakan ikuti langyq

Untuk menggambar class Diag
langkah berikut:

1. Buka Project dengan nama "Use Case, activity.uml” yang syday
kita buat pada Bab 5 sebelumnya.

: ; ﬂi’ﬂ?‘k%ﬂk:—,'iw'e“k\f“?"»m'“‘ i P
< =l Cpen e 0 —
- - v @ & & B>
Lookin: 4 Latihan
&} h B, ~
Recent Places )
Desktop Untitled.uml use case, use case.uml
. activity.uml
=
Libraries
Computer
§ -
Network e Ll ) e B
File name: use case, activity.uml v l___Oﬁpen ‘ | 4
Flesoftype: [ StarUML Project File(” umi) v [ Canca |

Gambar 6. 4 Open File Dialog

2. Pada Project yang kita buka ini, sudah terdapat dua model pada
kotak Model Explorer, yaitu: Use Case Model dan Activity Model.
Untuk membuat Class Diagram, kita perlu menambahkan satu
model lagi (ikuti langkah 3).
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MERE MR AR 3!

c ol
[&] Use Case Model
@ [&) Activity Model

@ Model Explorer | @ Diagram Explorer |
Gambar 6. 5 Model Explorer

3. Untuk menambahkan model baru ke dalam Model Explorer, klik
kanan icon kubus berlabel Untitled, pilih Menu Add, kemudian

klik Menu Model.

EIERE-ME A R

=W 1 Untitied
Zl Model ||  Add ,
@] Subsystem : Add Diagram » |
O Package |4 cut CtrX
Copy Ctr+C
B, Ppaste Ctri+V
Delete From Model Ctri+Del

Gambar 6. 6 Menu Add Model
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4 Ganti nama model yang baru dibuat dari “Modell” menjadi S

Model".

e S R

IR A AR
.. UseCaSE“b*l
@ @ Activity Model

-@Model&pbrer IDiagram Explorer l

Gambar 6. 7 Model Explorer

5. Untuk menambahkan Class Diagram baru ke dalam Class Model,

klik kanan Class Model, lalu pilih menu Add Diagram, kemudian
klik menu Class Diagram.
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P

EIENR- MAAR N
= % Untitled
& Use Case Model
B Activity Model

&
Add

»
2] Coss Diagram | Add Dagram -
%4 Use Case Diagram $ cut Crl+

t X
B Sequence Diagram By copy Ctri+C
Sequence Diagram (Role) [ X ;aste Cri+v

Gambar 6. 8 Menu Add Class Diagram

6. Nama class Diagram yang baru dibuat dapat diganti atau dibiar-
kan.

TIEAE-NE 2R W

= % Untitled
@ & Use Case Model
- @& Activity Model
= B Class Model

%] ClassDiagram1

2 (8% Mode! Explorer | (&) Diagram Explorer |

Gambar 6. 9 Model Explorer
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buka di Toolbox. Jika belun
tab Class sudah ter
! f:rstﬂ;klfan Izﬁkh:jvja kali Class Diagram1 pada Model Explorer,

M’:l

Annotation —_J
Class m—— e

r[g Select

Subsystem
[ Package

E Class

-0 Interface
Enumeration
Signal
Exception
1| Port

[O] Part

_| Assodation

T DirectedAssociation
_Y Aggregation

¥ Composition

_T Generalization

" Dependency
% Realization

= AssodationClass

Connector
=] Object ¥ {

Gambar 6. 10 Toolboy Class Diagram
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~ Untuk membuat class baru ke dalam area kerja, klik icon yang
berlabel Class di tab Class pada Toolbox, lalu klik tempat kosong
di area kerja. Ganti nama class nya menjadi “Biodata”.

¥ StarUML - use case, activity.uml TR

. File Edit Format Model View Tools Help

E|lsmmxocn IR

e

{ IR WE I

Subsystem
£ Package Biodata
E Class

-0 Interface

Enumeration %

Gambar 6. 11 Membuat Class Baru di Area Kerja

9. Untuk mengolah attribute dari class biodata, pastikan kotak Prop-
erties sudah memunculkan opsi seperti gambar 6.12 berikut. Jika
belum, klik terlebih dahulu class biodata yang ada di area kerja.
Jika sudah, klik tombol berlabel “.." seperti yang terlihat pada

gambar 6.12 berikut.
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T

i

E General .

& Name Biodata

¢ Stereotype .
v Visibility ¢ PUBLIC

@ IsAbstract D

O Operations {Collection)[0]

Detail

¢ IsSpedfication

# IsRoot

¢ Isleaf

O TemplateParameters  (Collection)[0]
¢ IsActive

O OO0

Gambar 6. 12 Membuat Attribute

10. Pada window Collection Editor, terdapat 4 tab yaitu Attributes,
Operations, Template Parameters, dan Relations. Untuk mengo-
lah attribute dari class biodata, pastikan tab Attributes sudah aktif
Di sebelah kiri window, di bawah text Attributes, terdapat empat
buah icon. Dari atas ke bawah, icon tersebut adalah:

58

a.
b.

C.

d.

Insert: untuk menambahkan attribute
Delete: untuk menghapus attribute

Move Up: untuk memindahkan urutan attribute satu tingkat ke
atas

Move Down: untuk memindahkan attribute satu tingkat ke
bawah
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¥ Collection Editor - (UMLClass) Biodata
atwbutes | Operatons | TenplateParameters | Reltons|

|
X |
¥

Gambar 6. 13 Collection Editor

11. Untuk menambahkan attribute baru, klik icon insert. Klik tiga kali
untuk menambahkan tiga buah attribute baru. Jumlah attribute
yang bisa dibuat tidak dibatasi. Perhatikan bahwa secara default,
attribute yang baru dibuat sudah memiliki visibility dan nama.
Perhatikan juga bahwa pengolahan attribute di window Collection
Editor akan secara otomatis memperbaharui Class Diagram kita
yang terdapat di area kerja.

e 1 D
4 Collection Editor - (UMLClass) Biodata o @8 = P
2 +A 1
Atrbutes [Operations [ Tenplateporameters [Relatens| || | Jiveues
o | oAtrbuter +Attribute3
bos ¢ Attribute2
© Attrbute3
1
4
I e v st e T s et a8 e
— =it

Gambar 6. 14 Menambahkan Attribute Baru
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o bute, type-expression, dap,

- icibility, nama attnbu' b :

12, l.Jr.‘t.Uk mfngg:;}tlsevéﬁglhl gttribute, terlebih dah_ulu Pblh:: attribyte
initial-value Collection Editor. Kemudian perhatikan bahwa kotal
tersebut di Colle beberapa properti atau opsi untyy

ies akan menampilkan pro '
Zg’r?lfc:;f;:n; dipilih. Jika kotak Properttes tidak muncul, pastikan,
bahwa menu View > Properties sudah tercentang.

Oq x

IProperﬁes
(UMLAttribute) Attributel | .-
SlGeneral ,

@ Name Attribute 1

& Stereotype

v Visibility ¢ PUBLIC

¢ Type

¢ InitialValue

E Detail

¢ IsSpedfication ™

+ Changeability CHANGEABLE

¥ TargetScope INSTANCE

+* Ordering UNORDERED

 Multiplicity

¥ OwnerScope INSTANCE

Gambar 6. 15 Attribute Properties

13. Pada contoh kali ini, kita sudah memili
biodata. Silakan atur
nilai sebagai berikut:

. . ki tiga attribute untuk class
properti masing masing attribute dengan

a. Attributl
i. Name : NIM
ii. Visibility : PRIVATE
iii. Type : String
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b Attribut2
"~ jv. Name
v. Visibility
vi. Type
vii. InitialValue
C Attrlbute3
viii. Name
ix. Visibility
x. Type :

perhatikan bahwa nilai properti di atas ha

- JumlahAdik
. PUBLIC

t Integer

0

- Namalengkap
: PUBLIC

String
nyalah contoh, tidak

mutlak har'us seperti itu, tetapi dapat disesuaikan dengan kebu-
tuhan analis.
WUMLCMSS) Biodata =@ %] Bodats
r’@f[ TemplateParameters | Relations | -NIM: String
m:/ﬁ_fl_ —— +umiahAdk: Integer = 0
0 % NIM: String +Namalengkap: String
| ¢ umiahAdik: Integer =0
X'| 5 Namalengkap: String ‘
t | |
+ T I
| |

Gambar 6. 16 Hasil Pengolahan Attribute

14. Untuk memindahkan urutan dari attribute, pilih attribute yang
ingin dipindahkan, lalu klik icon Move Up atau Move Down.
Urutan attribute akan otomatis dipindahkan.
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& = B 2 ]
& Collection Editor - (UMLClass) Biodata AP
o | % NM: String |
X | @ Namalengkap: String 1
N | @ umlahAdk: Integer = 0 ;
4 |l ;
| |
J |
| [
i 5
I E—

[ ome [ Heb J'

Gambar 6. 17 Memindahkan Urutan Attribute

15. Untuk menghapus attribute, pilih attribute yang akan dihapus,
lalu klik icon Delete.

1 (* Collection Editor - (UMLClass) Biodata

i F;f"_m [Cbuahslfamla@mmladaml
HNm:stng
L4 Namal.engkap: String

Gambar 6. 18 Menghapus Attribute

16. Tutup window Collection Editor jika sudah selesaj mengolah at-
tribute dari Class Biodata.
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] Tampilan sementara Class Biodata adalah seperti gambar 6.19
perikut:

Biodata

ANIM: String
+Namalengkap: String

Gambar 6. 19 Tampilan Sementara Class Biodata

18. Untuk mengolah method/operations dari Class Diagram, caranya
hampir sama dengan mengolah attribute-nya (langkah 9). Buka
terlebih dahulu Window Collection Editor (seperti langkah 9).
Cara lain untuk membuka Collection Editor adalah, klik kanan
class yang ada di area kerja, lalu pilih menu Collection Editor.

Add »
| NIM: String
+Namalengkap: String Add Diagram »
Select In Model Explorer  Ctri+M
Close Diagram Ctri+F4
Format >
Edit »
¢ Collection Editor... Ctri+FS

Gambar 6. 20 Menu Collection Editor

19. Untuk mengolah method/Operations dari class yang dipilih, klik
tab Operations. Sama seperti tab Attributes, tab Operations
JUdga terdapat empat buah icon. Dari atas ke bawah, icon tersebut
adalah:
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a. Insert: untuk menambahkan Oper.at[ons

b.  Delete: untuk menghapus Operations .

C.  Move Up: untuk memindahkan urutan Operations saty tingkay
ke atas . |

d. Move Down: untuk memindahkan Operations satu tingkat ke
bawah

—

i ( & Collection Editor - (UMLClass) Biodata
| Attributes | ¢ Operations | TemplateParameters | Relations| e

Gambar 6. 21 Collection Editor

20. Untuk menambahkan sebuah operations ke dalam class, klik tom-
bol Insert.
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e Editor - (UMLClass) Biodata
jp Collection o

| e owotns | ronlirancis | ors|

", e
X x
t| ;

2

Gambar 6. 22 Menambahkan Operations

71. Untuk mengubah visibility, name, parameter, type-expression dari
sebuah Operation, terlebih dahulu pilih Operation tersebut di
Collection Editor. Kemudian perhatikan bahwa kotak Properties
akan menampilkan beberapa properti atau opsi untuk Operation
yang dipilih. Jika kotak Properties tidak muncul, pastikan bahwa
menu View > Properties sudah tercentang.

[Elceneral

4 Name Operation1

¢ Stereotype

v Visibility 4 PUBLIC

¢ IsAbstract U
O Parameters {Collection)[0]
Bl Detail

¢ IsSpecification

¢ IsRoot

@ IsLeaf

v OwnerScope INSTANCE

¢ Spedfication

@ IsQuery

v Concurrency SEQUENTIAL
O RaisedSignals {Collection)[0] |

5 I

mimin

O

Gambar 6. 23 Operation Properties
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22. Untuk mengolah parameter dari suatu Operation, klik tombg| » «
yang ada di sebelah kanan properti berlabel Parameters, '

L(umoperauon) Operatml i 0 sl i 7
B General R T
" eName  Operationi
. @ Stereotype
v Visibility ¢ PUBLIC
[]
(Collection)[0]
@ IsSpedfication []
@ IsRoot O]
¢ Isleaf []
¥ OwnerScope INSTANCE
¢ Spedfication
@ IsQuery L]
v Concurrency SEQUENTIAL
O RaisedSignals (Collection)[0]

Gambar 6. 24 Membuat Parameters

23. Perhatikan window Collection Editor yang muncul. Terdapat tiga
buah tab, masing-masing berlabel Parameters, Raised Signals,
dan Relations. Pastikan bahwa tab Parameters dalam kondisi ak-
tif/terpilih, kemudian perhatikan bahwa terdapat empat buah icon
yang terdapat di bawah label Parameters. Dari atas ke bawah, icon
tersebut adalah:

a. Insert: untuk menambahkan parameter baru

b. Delete: untuk menghapus parameter

c. Move Up: untuk memindahkan urutan parameter satu tingkat
ke atas

d. Move Down: untuk memindahkan urutan parameter satu

tingkat ke bawah
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& Collection Editor - (UMLOperation) Operation1

[—— i

| e ——

” e et i

= = ¥

Gambar 6. 25 Window Collection

24. Untuk menambahkan sebuah parameter baru, klik tombol insert.

{ ¥ Collection Editgr - !ng.Operaﬁon) Operationl

Parameters |Raised Signals | Relations |

Gambar 6. 26 Menambahkan Parameter Baru
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25. Untuk mengganti nama, visibility, type, dan nilai default untuk se.
buah parameter, dapat dilakukan melalui window Properties,

S
Properties LIRS Yy a4

R

}_(y_i'ltparametgr) Parameter |

SlGeneral A
| @ Name Parameter1

¢ Stereotype ’
l
i
l

~ Visibility ¢ PUBLIC

@ Type

¢ Defaultvalue

El Detail

@ IsSpedification L]
¥ DirectionKind IN

Gambar 6. 27 Parameter Properties

26. Perubahan properti untuk parameter yang dilakukan di window
Properties akan langsung terlihat di Class Diagram yang ada di

area kerja.
|Properties 0o x|
[(UMLParameter) parama |
5 s bt
Biodata | @ Name paramA
-NIM: String . | @ Stereotype
+Namalengkap: String v visbility ¢ PUBLIC
+Operation 1{paramA: String = nilaiAwal) | @ Type String :
|| @ Defaultvalue _ nilaiAwal |
& Detail _4
%) .| | *lsSpedficaton U
il vOrectoind @ 0w 0000000 0 |

Gambar 6. 28 Class Biodata dan Window Properties

27. Simpan Project kita dengan nama “Use Case, Activity, Class.uml”.
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H_r' ,_;ve %

Savein: i Latihan = (X AR
B Name Date modified Type
~p Buntitied.uml 3/20/20121047 AM  StarUML F
Recent Places ) se case, activity, class.uml 4/12/2012431PM  StarUMLF
. Bluse case, activity.uml 3/22/201211:46 PM  StarUML F
Bluse case.uml 3/21/20128:09 PM  StarUML F
Desktop
|l
Libraries
Computer
z ¢ s manllle s j ’
Network T " =
File name: use case, activity, class.uml v l Save l
Saveastype: [ StarUML Project Fief umi) -]

Gambar 6. 29 Save File Dialog
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BAB VII

Séquence Diagram

Pengertian Sequence Diagram

enurut John Satzinger, 2010, dalam buku System Analysis and
Design in a Changing World, “System sequence diagram (SSD)
adalah diagram yang digunakan untuk mendefinisikan input

dan output serta urutan interaksi antara pengguna dan sistem untuk
sebuah use case.”

Notasi Sequence Diagram

The actor An object

interacting with {underlined)
[ the system ; 2 7 D representing the
[ automated system
5
:System
5 An input message
": Clerk T
- | . |
A | inquireOnitem (cataloglD, prodID, size) 1 The object lifeline; shows
;s > the “sequence” of messages,
{3 | | top to bottom
\ | |
‘ N SR, 1 -
| item information | item information:
| | description, price, quantity
| |
A returned value
| - — Opticnal note to explain
something in a diagram

Gambar 7. 1 Notasi Sequence Diagram

Sumber: System Analysis and Design in a Changing World, 2010




Actor: mewakili seorang aktor (orang atau peran yang berinteraj;
dengan sistem). _ -

Kotak berlabel : System adalah objek yang mewakili keseluryhg,,
sistem yang terotomatisasi. _

Garis putus-putus vertikal (lifelines) adalah Pérpanjangan obje
tersebut, baik aktor maupun objek, sepanjang durasi dari Sequence
Diagram. L

Anak panah antara lifeline mewakili message yang dikirim ata,
diterima oleh aktor dari sistem.

Message diberi label untuk menggambarkgn mgksud message dan
input apa pun yang sedang dikirim. Message dipertimbangkan sebagai
sebuah aksi yang diminta pada tujuan objek, kebanyakan sepert;
perintah.

Langkah-langkah Membuat Sequence Diagram di
StarUML

1. Buka Project dengan nama “Use Case, Activity, Class.uml” yang
sudah kita buat pada Bab 6 sebelumnya.

4 Cpen
Lookin:  J, Latihan S e E
P Name i Date modified Type
~p Buntitied.um 3/20/20121017 AM  StarUML £
Recent Places  Riuse case, activity, ciass.umi 4/12/20124:57 PM___ StarUML f
. Buse case, activity.uml 3/22/201211:46 PM  StarUML f
) B use case.uml 3/21/20128:09 PM  StarUML F
Desktop
Libraries
A
Computer
-
@ /)| s S »
Network L T R R,
File name: use case, activity, class uml v [ Open #
Flesoftype: | StarUML Project Fle umi) v [ cancel

Gambar 7. 2 Membuka Project “Use Case, Activity, Class.uml’
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2. Dalam file project ini sudah terq

apat tiga b :
Case Model, Activity Mo % e Pat tiga buah model, yaitu Use

n Class Model.

LR MEAER

2 9 Untted
Use Case Model
@ ] Activity Model
@ [ Class Model

Gambar 7. 3 Tiga Buah Model yang Ada di Project Latihan

3. Untuk membuat model baru yang akan digunakan dalam me-
nampung sequence diagram, klik kanan kubus yang berlabel Un-
titled, lalu pilih menu Add, kemudian klik menu Model.

2 Model | Add >
(4] Subsystem ‘ Add Diagram >
1 Package £ Cut Ctri+X
S Copy Ctr+C
#, Paste Ctri+V

Delete From Model Ctrl+Del

unit 3

Gambar 7. 4 Membuat Sequence Model
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4. Beri nama model yang baru ini dengan nama Sequence Mode],

TR @ EX
29 Unutled
[A] Use Case Model
Activity Model
#- & Class Model

= 1 Sequence Model

Gambar 7. 5 Memberi Nama Sequence Model

5. Tambahkan sebuah Sequence Diagram yang baru ke dalam Se-
quence Model ini.

3 ml;{%'tq* T 2
= % Untitled
@ 2] Use Case Model
@ @ Activity Model

@ (B Class Model
B < cuence Mod
Add y
Class Diagram Add Diagram 4 J'
% Use Case Diagram & cut Ctrl+X N
_@sequancebbmm ]‘% Copy CrkC

Sequence Diagram (Role) Paste Cr+V
A colaboration Diagram Delete From Model Ctri+Del

Gambar 7. 6 Menambahkan Sebuah Sequence Diagram ke Dalam Sequence
Model
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6. Ubahlah nama masing-masing diagram:
a. SequenceDiagraml: SequenceDiagramMelihatInfoBiodata

b. InteractioninstanceSetl: InteractioninstanceSetMelihatInfoBio-
data

¢. CollaborationinstanceSet1: CollaborationinstanceSetMelihatin-
foBiodata

= % Untitied
& Use Case Model
- & Activity Model
#- & Class Model
=) E] SequenceModel
=+ CollaborationInstanceSetMelihatinfoBiodata
=] g InteracbonlnstanoeSeMelihatInfoBlodata

5] SequenceDiagramMelihatinfoBiodata

m

Gambar 7. 7 Mengganti Nama Diagram

7. Perhatikan di window Toolbox terdapat tab berlabel Sequence.
Jika tidak, klik dua kali label SequenceDtagramMeI|hatInfoB|odata
yang terdapat di window Model Explorer.

Annotation ,
e RN 3|
"Iy select

=1 Object

— Stimulus |
2 selfStimulus )
] Combined Fragment

[5] Interaction Operand _
7] Frame '

I

| Toolbox 1 XH
-
l

Gambar 7. 8 Tab Sequence di Toolbox
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8. Untuk membuat sebuah actor dalam Sequence _Diagram, klik icon
berlabel Object yang ada dalam tab Sequence di Toolbox. Lalu klik
sekali di tempat kosong di area kerja.

& StarUML - use case, m_

| fle Edt Format Model View Tools Help

NS ES e XvonRBRRGE, (100% a9
T JaseRaédzEzs|Sma
Annotation Loty = A ,
Sequence

I3 select

=) Object

— Stimulus

a selfstimulus

] Combined Fragment
[} Interaction Operand
E] Frame

3 >

R S

Gambar 7. 9 Membuat Object Baru yang dijadikan Actor

9. Klik tombol “.." yang terdapat pada window Properties, di sebelah
kanan properties berlabel Classifier.

Ll oax
'(UMLObject) Object1 ]
El General - e :M:V';:f
i @ Name Object1 ]
| ¢ Stereotype a

v Visibility 4 PUBLIC

(Collection)[0]
E Detail s Ohe T I
¢ IsSpedfication ] |
@ IsMuIﬁInstance ]

Gambar 7. 10 Mengubah Jenis Classifier untuk Object yang Dijadikan Actor
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10. Pada window Select a model element yang muncul, pilih Actor

yang berlabel Mahasiswa, lalu tekan tombol OK.

| select a model element.

| —
AEIE MR 2R I
= % Untitled
= &) Use Case Model

> Melihat Info Biodata
Ly
B Activity Model
- &) Class Model
' 2] Sequence Model

[7] Do not spedify
i::Use Case Model: :Mahasiswa |

- [ :

Gambar 7. 11 Memilih Actor Mahasiswa sebagai Model Element.

11. Hapus nama object-nya sehingga hasilnya seperti gambar 7.12

berikut;

Sequence Diagram
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& StarUML - use case, activity, dassuml '
Tools Help

:'Eiegthgrmatm_odd!vew

o selfstmuius
] Combined Fragment
[ Interaction Operand ) :
F’] Frame i :

_ J‘
. | %
—b Stimulus ’,
i
|

Gambar 7. 12 Menghapus Nama Object

12. Untuk menambahkan sebuah instance baru ke dalam Sequence
Diagram, klik icon berlabel Object yang terdapat pada tab Se-
quence di dalam window Toolbox, lalu klik sekali di tempat kosong

di area kerja.

4 StarUML - use case, activity, class.uml ; . g

. Fle Edt Format Model Vew Toos Help

C "

S

[Toabox

Annotation
Sequence
[Ty select | |

= Object

— Stimulus %

o SelfStimuius Mahasiswa
] Combined Fragment :

£] Interaction Operand :

] Frame

'
.

Gambar 7. 13 Membuat Sdbuah Instance Baru
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13. Klik tombol “_. yang berada di sebelah kanan

ok properti yang ber-
label Classifier pada window Properties. ok

Object1

¢ PUBLIC
{Collection)[0]
N
@ IsSpedfication ]
@ IsMultinstance O

Gambar 7. 14 Mengubah Classifier untuk Object yang Dijadikan Instance

14. Di window “Select a model element”, pilih Class Biodata, laly
tekan tombol OK.

Select a mode! element.

FEE- B IR
|E 9§ Untitled

| @ [ Use Case Model ;
| & [& Class Model ‘

|
] Bodata | |

[2) Sequence Model

Gambar 7. 15 Memilih Class Biodata Sebagai Model Element
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15. Jika ingin membuat object multi instance, centang properti sMu|-
tilnstance yang terdapat dalam window Properties pada kolom

Detail.
| Properties oa x|
| (UMLObject) Object1 e o
SlGeneral
@ Name Object1
¢ Stereotype
« Visibility ¢ PUBLIC
@ Classifier Biodata
O Slots (Collection)[0]
El Detail
@ IsSpedfication []
¢ IsMultilnstance

Gambar 7. 16 Properti untuk Mengatur Multi Instance Atau Single Instance

& StarUML - use case, activity, classuml =
. Fle Edit Format Model View Tools Help
DEE&| B X oo RBIH |2 8. 100%

[ T Aase R m &l |
(Toobox 1 x| SequenceDiagram1. (Sequence Modek:: Collaboratior 1
Syiation () SequenceDiagramMelihatirifoBiodata |

T G

; k Select ject1 : Biodata
=) Object

— Stimulus % T

& selfstmulus 5 i Mahasiswa :

£ Combined Fragment

[5] Interaction Operand :

] Frame

Gambar 7. 17 Bentuk Single Instance dari Object1
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pswon iy oo e
oo

gle Edt Fomat Model Vew Tools Hep
GHE LBBR X 0N QIAF |9 8. |100% d
- 1__lasd|0paa|zz5|s0

— | '
[Toobox ool 5

a sefstmuks 4 Mohasiona
{] Combined Fragment
[ Interaction Operand ,
£ Fame |

Gambar 7. 18 Bentuk Multi Instance dari Object1

Klik icon berlabel Stimulus yang ada di tab Sequence. Lalu klik-
tahan-seret mulai dari lifeline Actor Mahasiswa sampai lifeline
Objectl. Beri nama Stimulus ini, misalnya Perintah1.

«F StarUML - use case, activity, class.uml
‘He Edt Fomat Model View Tools Help

RN
S
RGBS e

ap-2"F=2 l‘> oo B3EAEF G %, 100% -QGLIIJ
#,-_.,jii EEER VYR = rv!"":’_;‘,\&&‘ ;
Toobox 1 x| wml(sﬂmcm ColaborationinstanceSetL:Ints it :
Annotation @Seqm\cd)agrmﬂei\aunfo&odab,

SpETea -

I Select Obiect1 : Biodata

& Object

~ Stmulus '__5

4 SelfStimulus : Mahasiswa .:

B Combined Fragment :

 Interaction Operand ; '

] Frame f—_lg ¢ Perintah1 N

-

Gambar 7. 19 Menambahkan Stimulus Baru ke dalam Sequence Diagram

Sequence Diagram 81




16. Setelah mengetikkan nama untuk Stimulus, tekan Enter,

C o St smcse, oy oo S o N

fle Edt Format Model View Tools Help

DEES amX[o-RhRFAR[SEF. 0% .
] JAsdRadd (T2 sn
[fosbox cquenceDiagram ' i
Annotation

Sequence |

rﬁ’s‘l l’“ e Obiect1 : Biodata

= Object ] -

— Stimulus |

] Combined Fragment | ,
Interaction : 5
g % ey | ! 1: Perintah1() o
. | § 1

|

}
I

Gambar 7. 20 Tampilan Sequence Diagram dengan Sebuah Stimulus

17. Klik Stimulus Perintahl(), lalu coba masukkan nilai Arguments
dan Return seperti gambar 7.21 berikut. Perhatikan bahwa secara
default nilai Arguments tidak ditampilkan dalam Stimulus.

r =m

| aiverdi=permanig |

| ¢ Arguments Var1, Var2

| @Retun var3
@ Iteration
@ Branch.

;& P;;perh; IZI D;GA.;’EQ'\!&!OF‘ E Attachments .

Gambar 7. 21 Mengganti Nilai Properti dari Stimulus
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18. Untuk menampilkan nilai Arguments pada Sequence Diagram, klik
tempat kosong di area kerja. Ganti nilai properti MessageSigna-
ture menjadi NAMEANDTYPE.

Obiect1 : Biodata Properties 0
: ElGene:
: Mahasiswa : ’ @ Name SequenceDiagramMelhatinfoSiod

& DaganType
! : B Detail
} $ [ @ ShowSequenceNumber v
! 1:Var3:=Perintahi{varl, Var2)  : i 4 1
: '[:l # ShowActivation v

-ﬁP;o;'ﬂes I é] Doct;;énmmr &i A(!#“meﬂs

Gambar 7. 22 Menampilkan Message Signature

19. Klik icon berlabel Stimulus yang ada di tab Sequence, lalu klik-
tahan-seret mulai dari lifeline Objectl sampai lifeline Actor Ma-
hasiswa. Beri nama Stimulus ini, misalnya konfirmasi. Lalu ubah
properti ActionKind menjadi RETURN.
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Object1 ; Biodata Praperties &
% | (UMLStimulus) konfirmasi Sl =
; 57 T B,
- Mahasiswa ' @ Name konfirmasi

; ; & Stereotype

: : ~ Visibility ¢ PpuBLIC
| |+ ActionKind - ;_ RETURN
B Detail 3

: 'U [ & IsSpedification

¢ Arguments

4 Return

@ Iteration

2 : konfirmasi ' .2

! 1:Var3 :=Perintah1(Var1, var2) i

:-P"";’;u;—l ;B»Do:mn;e;;;sbonr %A‘tta;rmeats —

——)

Gambar 7. 23 Membuat Returned Value

20. Simpan project dengan nama “use case, activity, class, sequence.
uml”.
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BAB VIII

STUDI KASUS

Analisis Sistem

SION (Sistem Informasi Kampus Online) adalah sebuah perangkat
lunak berbasis web yang dikembangkan oleh STMIK STIKOM Bali
untuk membantu para mahasiswanya mendapatkan informasi tentang
perkuliahan. Informasi mengenai jadwal kuliah, kehadiran, jadwal
ujian, nilai, jadwal perwalian, pembayaran, biodata, pengumuman-
pengumuman, serta informasi-informasi lain yang berhubungan
dengan perkuliahan dapat dengan mudah diakses oleh para mahasiswa
secara online melalui koneksi Internet dengan mengarahkan web
browser mereka ke alamat http://sion.stikom-bali.ac.id.

Setelah dilakukan evaluasi terhadap sistem yang sedang berjalan,
ditemukan beberapa kelemahan sebagai berikut:

1. Layar monitor yang digunakan harus memiliki resolusi minimal
800 x 600 pixel agar halaman website SION dapat ditampilkan
dengan sempurna. Hal ini tentu menghambat Mahasiswa untuk
melihat informasi yang ada pada website SION melalui layar pon-
sel dengan resolusi layar monitor di bawah 800 x 600 pixel.

2. Web browser yang digunakan harus memiliki kemampuan men-
golah HTML, CSS, dan Javascript. Web browser yang disarankan
adalah Mozilla Firefox. Web browser yang ada di ponsel memiliki
fitur dan teknologi yang berbeda-beda, terlebih lagi dalam pen-
anganan javascript.

3. Sebuah halaman website SION dapat memiliki size sebesar 236

KB, terdiri dari document php, file gambar, file javascript, dan file
ESS.



Untuk mengatasi kelemahan sistem yang ada sekarar}g, maka
dikembangkan sebuah mobile application untuk mengakses informas;
biodata, perkuliahan, perwalian, dan pembayaran padg STIKOM Bal;.
Untuk selanjutnya sistem yang akan dirancang ini disebut dengan
SION2ME. Dalam buku ini penulis membatasi pembahasan hanya
sampai pengaksesan informasi biodata saja.

Dalam perancangan dan pembangunan mobile application ini akan
digunakan:
1. Teknologi J2ME sebagai bahasa pemrograman
2. XML dan JSON sebagai format untuk menampilkan data
3. Koneksi Internet dengan protocol HTTP yang digunakan untuk
menghubungkan antara mobile application yang berbasis J2ME
ini dengan website SION
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perancangan Sistem

yse Case Diagram untuk SION2ME

System

@perhahami data @
/

S M

R 8]

Pt = |

Gambar 8. 1 Use Case Diagram SION2ME

Use Case Descriptions untuk SION2ME
Tabel 8. 1 Fully Developed Description: Memperbarui Data Login

Use Case Name: Memperbarui data login

Scenario: Memperbarui data /ogin di ponsel J2ME

Triggering Event: 1. Sistem dijalankan untuk pertama kalinya
2. Mahasiswa menekan tombol Logout

Brief Description: Ketika sistem dijalankan untuk pertama kalinya, atau ketika ma-
hasiswa menekan tombol /ogout, sistem menampilkan halaman
login, mahasiswa memasukkan data login, sistem memvalidasi
data login, menyimpan data login, dan menampilkan halaman
utama.

Actors: Mahasiswa

‘| Related Use cases:
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Stakeholders:

dan kembali ke langkah 1

Preconditions: Data login (NIM dan password) di RMS ponsel belum terisi |
Postconditions: 1. Data login tersimpan di RMS ponsel
2. Sistem menampilkan halaman utama
Flow of Activities: Actor System
1, = Sistem menampilkan hala-
man login
2. Mahasiswa memasuk-
kan data login (NIM dan
password SION)
3. Mahasiswa menekan
tombol login .
Sistem menampilkan ani-
masi loading sebagai tanda
bahwa proses sedang ber-
jalan
Sistem membuka koneksi
HTTP
Sistem memvalidasi data
login ke webserver SION
Sistem menyimpan data
login di RMS ponsel
Sistem menampilkan hala-
man utama
Exception 6.1  Jika sistem tidak dapat menghubungi webserver SION,
Conditions: tampilkan pesan koneksi error dan kembali ke langkah 1
6.2 Jika data login tidak valid, tampilkan pesan gagal login

e
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Tabel 8. 2 Fully Developed Description: Melihat Info Biodata

m Melihat info biodata

scenario: Melihat info biodata melalui ponsel J2ME

Triggering Event: Mahasiswa menekan tombol biodata di halaman utama

prief Description: Ketika mahasiswa menekan tombol biodata di halaman utama,
sistem menghubungi webserver SION, mem-parsing dan me-
nampilkan halaman biodata '

Actors: Mahasiswa

Related Use Cases: -

stakeholders: = '

preconditions: Data /ogin (NIM dan password) di RMS ponsel tidak boleh ko-
song

postconditions: Sistem menampilkan informasi biodata mahasiswa

Flow of Activities: Actor System

1. Mahasiswa menekan tombol | 1. -
biodata di halaman utama

2. Sistem menampilkan
animasi loading se-
bagai tanda bahwa
proses sedang ber-
jalan

3. Sistem mengambil
data NIM, password,
dan pilihan format
(XML atau JSON) di

RMS ponsel

4. Sistem membuka
koneksi HTTP

5. Sistem meminta

halaman biodata
ke webserver SION
sesuai dengan NIM,
password, dan pili-
han format yang di-
dapat dari langkah 2
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Flow of Activities:

Actor System

6. Sistem mem-parsing
halaman biodata
yang masih berup,
format XML atay
JSON

7. Sistem menampilkan
informasi  biodata
yang sudah di-pars-
ing

8. Sistem menghilang-
kan animasi loading

9. Sistem menutup
koneksi HTTP

Exception Conditions:

5.1 Jika sistem tidak mampu menghubungi webserver SION,

6.1 Jika sistem tidak mampu mem-parsing halaman biodata,

sistem akan menampilkan pesan koneksi error dan lang-
sung menuju langkah 8

sistem menampilkan pesan error dan langsung
menuju langkah 8

Tabel 8. 3 Fully Developed Description: Logout

Use Case Name:

Logout

Scenario: Logout dari ponsel J2ME

Triggering Event: Mahasiswa menekan tombol Logout

Brief Description: Ketika mahasiswa menekan tombol logout, sistem
menghapus data /ogin di RMS dan menampilkan hala-
man login

Actors: Mahasiswa

Related Use Cases: -

Stakeholders: -

Preconditions: Halaman utama sudah tampil

Postconditions: 1. Data login terhapus dari RMS ponsel A

2. Sistem menampilkan halaman login o
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/‘—' o e,
Flow of Activities:

Actor

System

1. Mahasiswa menekan tombol
logout

. Sistem meng-

hapus data
login di RMS
ponsel

. Sistem me-

nampilkan
halaman /ogin

Exception

C onditions:

Activity Diagram untuk SION2ME

System

start

menamp@ian halaman logn

Gambar 8. 2 Activity Diagram: Memperbarui Data Login
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92

(menganti data NIM, password, den plhan Formet d RMS )

membuka koneksi HTTP

Gambar 8. 3 Activity Diagram: Melihat Info Biodata
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menghapus dta login & RHS ponsel )

i @<

‘Gambar 8. 4 Activity Diagram: Logout
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Gambar 8. 5 Class Diagram untuk SION2ME
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sequence Diagram untuk SION2ZME

Gambar 8. 6 Sequence Diagram: Memperbarui Data Login
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=

i
Ii

=

il

© 141 ipdstelnentiodata, heSodata)

:
T ?
it ;

13 cestelRipwameter)

s
gl
; H

JI

JiL

getContent()
{17 newBiodats := parselsaaText, plharformat)
RSO neatiodata)

il

Gambar 8. 7 Sequence Diagram: Melihat Info Biodata
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: SIONZME SION2MEMahasiswa : Mahasiswa 1

: mahasiswa

+ 1: Logout{NIM, péssword)

s e s

J

2 : theMahasiswa : = ﬁndMa.hasiswa(NIM, password)

I

i 3 : delete{theMahasiswa)

Gambar 8. 8 Sequence Diagram: Logout
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